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Disclaimer

This document and all the information contained within it is proprietary to Armfield
Limited. This document must not be used for any purpose other than that for which it
is supplied and its contents must not be reproduced, modified, adapted, published,
translated or disclosed to any third party, in whole or in part, without the prior written
permission of Armfield Limited.

Should you have any queries or comments, please contact the Armfield Customer
Support helpdesk (Monday to Thursday: 0830 — 1730 and Friday: 0830 - 1300 UK
time). Contact details are as follows:

(0) 1425 478781 _ +44 (0) 1425 478781
(calls charged at local rate) (international rates apply)

Email: support@armfield.co.uk

Fax: +44 (0) 1425 470916

Copyright and Trademarks
Copyright © 2012 Armfield Limited. All rights reserved.

Any technical documentation made available by Armfield Limited is the copyright
work of Armfield Limited and wholly owned by Armfield Limited.

Brands and product names mentioned in this manual may be trademarks or
registered trademarks of their respective companies and are hereby acknowledged.




General Overview

Fluid mechanics has developed as an analytical discipline from the application of the
classical laws of statics, dynamics and thermodynamics, to situations in which fluids
can be treated as continuous media. The particular laws involved are those of the
conservation of mass, energy and momentum and, in each application, these laws
may be simplified in an attempt to describe quantitatively the behaviour of the fluid.

The hydraulics bench service module, F1-10, provides the necessary facilities to
support a comprehensive range of hydraulic models each of which is designed to
demonstrate a particular aspect of hydraulic theory.

The specific hydraulic model that we are concerned with for this experiment is the
Energy Losses in Bends and Fittings Rig, F1-22. A full description of the apparatus is
given later in these texts.



Equipment Diagrams
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Figure 1: F1-22 Energy Losses in Bends Apparatus




Important Safety Information

Introduction

Before proceeding to operate the equipment described in this text we wish to alert
you to potential hazards so that they may be avoided.

Although designed for safe operation, any laboratory equipment may involve
processes or procedures which are potentially hazardous. The major potential
hazards associated with this particular equipment are listed below.

¢ Injury through misuse

¢ Injury from electric shock

e« Damage to clothing

+ Risk of infection due to lack of cleanliness

Accidents can be avoided provided that equipment is regularly maintained and
staff and students are made aware of potential hazards list of general safety rules is
included in the F1 Product Manual to assist staff and students in this regard. The list
is not intended to be fully comprehensive but for guidance only.

Please refer to the notes in the F1 Product Manual regarding the Control of
Substances Hazardous to Health Regulations.

Electrical Safety

The F1-10 Service Bench operates from a mains voltage electrical supply. The
equipment is designed and manufactured in accordance with appropriate regulations
relating to the use of electricity. Similarly, it is assumed that regulations applying to
the operation of electrical equipment are observed by the end user.

However, to give increased operator protection, Armfield Ltd have incorporated a
Residual Current Device (RCD, alternatively called an Earth Leakage Circuit Breaker
or ELCB) as an integral part of the service bench. If through misuse or accident the
equipment becomes electrically dangerous, an RCD will switch off the electrical
supply and reduce the severity of any electric shock received by an operator to a
level which, under normal circumstances, will not cause injury to that person.

Check that the RCD is operating correctly by pressing the TEST button. The circuit
breaker MUST trip when the button is pressed. Failure to trip means that the operator
is not protected and the equipment must be checked and repaired by a competent
electrician before it is used.



Description
Where necessary, refer to the drawings in the Equipment Diagrams section.

Overview

The accessory is designed to be positioned on the side channels of the hydraulics
bench top channel.

The following fittings are connected in a series configuration to allow direct
comparison:

e long bend
e area enlargement
« area contraction
e elbow bend
» short bend
o valve fitting
e mitre bend
Flow rate through the circuit is controlled by a flow control valve.

Pressure tappings in the circuit are connected to a twelve bank manometer, which
incorporates an air inlet/outlet valve in the top manifold. An air bleed screw facilitates
connection to a hand pump. This enables the levels in the manometer bank to be
adjusted to a convenient level to suit the system static pressure.

A clamp which closes off the tappings to the mitre bend is introduced when
experiments on the valve fitting are required. A differential pressure gauge gives a
direct reading of losses through the gate valve.




Installation

Installing the Equipment and Commissioning

The Energy Losses in Bends apparatus is supplied ready for use and only requires
connection to the F1-10 Hydraulics Bench as described below.

Carefully remove the components from the cardboard packaging. Retain the
packaging for future use.

Locate the apparatus over the moulded channel in the top of the bench and ensure
that the base plate is horizontal. Adjust the feet on the base plate if necessary.

Connect the flexible inlet tube at the left hand end to the quick release fitting in the
bed of the channel.

Place the free end of the flexible outlet tube in the volumetric tank of the bench.

Fully open the gate valve and the outlet flow control valve at the right hand end of the
apparatus.

Close the bench flow control valve then start the service pump.

Gradually open the bench flow control valve and allow the pipework to fill with water
until all air has been expelled from the pipework.

In order to bleed air from the pressure tapping points and the manometers close both
the bench flow control valve and the outlet flow control valve and open the air bleed
screw. Remove the cap from the adjacent air inlet/outlet connection. Connect a
length of small bore tubing from the air valve to the volumetric tank. Now, open the
bench flow control valve and allow flow through the manometers to purge all air from
them; then, tighten the air bleed screw and partly open both the bench valve and the
outlet flow control valve. Next, open the air bleed screw slightly to allow air to enter
the top of the manometers, re-tighten the screw when the manometer levels reach a
mid height.

Gradually increase the volume flowrate until the pattern just fills the range of the
manometer (adjust the bench flow control valve and the outlet flow control valve in
combination to maintain all of the readings within the range of the manometer). If the
pattern is too low on the manometer open the bench flow control valve to increase
the static pressure. If the pattern is too high open the outlet flow control valve on the
apparatus to reduce the static pressure.

These levels can be adjusted further by using the air bleed screw and the hand pump
supplied. The air bleed screw controls the air flow through the air valve, so when
using the hand pump, the bleed screw must be open. To retain the hand pump
pressure in the system, the screw must be closed after pumping.

If the levels in the manometer are too high then the hand pump can be used to
pressurise the top manifold. All levels will decrease simultaneously but retain the
appropriate differentials.

If the levels are too low then the hand pump should be disconnected and the air
bleed screw opened briefly to reduce the pressure in the top manifold. Alternatively



Installation

the outlet flow control valve can be closed to raise the static pressure in the system
which will raise all levels simultaneously.

If the level in any manometer tube is allowed to drop too low then air will enter the
bottom manifold. If the level in any manometer tube is too high then water will enter
the top manifold and flow into adjacent tubes.

Note: If the static pressure in the system is excessive, Eg. with the bench flow
control valve fully open and the outlet flow control valve almost closed, it will not be
possible to use the hand pump to lower the levels in the manometer tubes. The
valves should be adjusted to provide the required flowrate at a lower static pressure.

In operation the pressure drop across each fitting is compared with the volume
flowrate which is measured using the volumetric measuring tank and a stopwatch
(not supplied).

To check the operation of the differential pressure gauge associated with the gate
valve, close off the flexible connecting tubes to the mitre bend pressure tappings
using the clamps supplied before closing the gate valve (to prevent air being drawn
into the system).

Open the bench flow control valve and the outlet flow control valve. As the gate valve
is closed the differential pressure across the valve will be displayed on the gauge.

Close the bench flow control valve then switch off the service pump.

The F1-22 Energy Losses in Bends apparatus is ready for use.




Operation

Operating the Equipment

See Laboratory Teaching Exercises for details on operating the equipment.



Equipment Specifications

Environmental Conditions

This equipment has been designed for operation in the following environmental
conditions. Operation outside of these conditions may result reduced performance,
damage to the equipment or hazard to the operator.

a. Indoor use;
b. Altitude up to 2000m;
c. Temperature 5°C to 40°C;

d. Maximum relative humidity 80% for temperatures up to 31°C, decreasing
linearly to 50% relative humidity at 40°C;

e. Mains supply voltage fluctuations up to +10% of the nominal voltage;
f. Transient over-voltages typically present on the MAINS supply;

Note: The normal level of transient over-voltages is impulse withstand (over-
voltage) category Il of IEC 60364-4-443;

g. Pollution degree 2.
Normally only nonconductive pollution occurs.
Temporary conductivity caused by condensation is to be expected.

Typical of an office or laboratory environment.




Routine Maintenance

Responsibility

To preserve the life and efficient operation of the equipment it is important that the
equipment is properly maintained. Regular maintenance of the equipment is the
responsibility of the end user and must be performed by qualified personnel who
understand the operation of the equipment.

General

Little maintenance is required but it is important to drain all water from the pipework
when not in use. The air tapping on the top manifold of the manometer can be used
to eject all water from the manometer tubes by opening the bleed valve then using
the hand pump if necessary.

Any manometer tube which does not fill with water or is slow to fill or empty indicates
that the tapping in the pipework or the connection at the base of the manometer tube
is blocked or partially blocked. Disconnect the flexible connecting tube between the
pipe fitting and the manometer. Blowing through the tapping will usually dislodge any
foreign body.

A few drops of wetting agent introduced into the manometer tubes will reduce the
meniscus with the glass wall and improve measurement accuracy.
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Laboratory Teaching Exercises

Index to Exercises

Exercise A

Nomenclature

Diameter of Test Pipe d Given Internal diameter of test pipe.
Volume Collected me Vv Measured Taken from scale on hydraulics
bench
Time to Collect s t Measured |Time taken to collect the
known volume of water in the
hydraulics bench.
Temp of Water °C Measured IeiTperature of water under
Kinematic Viscosity {(m?s) |v Measured |Taken from the table Kinematic
Viscosity of Water at
Atmospheric Pressure
Manometer m h, Measured Measur(_ed value from the
appropriate manometer.
Note: Scale calibrated in mm.
Manometer m h, Measured Measurgd value from the
appropriate manometer.
Note: Scale calibrated in mm.
Timed Flow R ’ Calculated | Qe V _ Volume Collected
imed Flow Rate m'/s | Q alculate t : Time to Collect
Velocity of fluid in duct =
Velocity mis |{v Calculated
Q¢ _ Flow ERate
A Area
Calculated | ¥°
Dynamic Head m aloulated | *
2g
wvd
Reynolds Number Re Calculated | ke = —

(i
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Head | the fitti
Head Loss/ Pressure ead loss across he fting

D m Ah Calculated
rop Ah=tyhy

~Bheg

Loss Coefficient K Calculated | K 5
v See Theory

Technical Data

The following dimensions from the equipment are used in the appropriate
calculations. If required these values may be checked as part of the experimental
procedure and replaced with your own measurements.

Internal diameter of pipework: d =0.0183m

Internal diameter of pipework at enlargement outlet and contraction inlet:

d = 0.0240m

12



Exercise A

Objective

To determine the loss factors for flow through a range of pipe fittings including bends,
a contraction, an enlargement and a gate-valve.

Method

By measurement of head differences across each of a number of fittings connected
in series, over a range of steady flows.

Equipment
In order to complete the demonstration we need a number of pieces of equipment.

» The F1-10 Hydraulics Bench which allows us to measure flow by timed
volume collection.

o The F1-22 Energy Losses in Bends and Fittings Apparatus.

* A stopwatch to allow us to determine the flow rate of water (not supplied).
o Clamps for pressure tapping connection tubes.

o Spirit level (not supplied).

e Thermometer (not supplied).

Theory

The energy loss which occurs in a pipe fitting (so-called secondary loss) is commonly
expressed in terms of a head loss (h, metres) in the form:

where K = the loss coefficient and v = mean velocity of flow into the fitting.

Because of the complexity of flow in many fittings, K is usually determined by
experiment. For the pipe fitting experiment, the head loss is calculated from two
manometer readings, taken before and after each fitting, and K is then determined as

Ah

K=
vszg

Due to the change in pipe cross-sectional area through the enlargement and
contraction, the system experiences an additional change in static pressure. This
change can be calculated as

Vlz 'd’22

2g 2g

To eliminate the effects of this area change on the measured head losses, this value
should be added to the head loss readings for the enlargement and the contraction.

13
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V12 ‘fzz

2g

Note that (h, — h,) will be negative for the enlargement and 2g will be

negative for the contraction.

For the gate valve experiment, pressure difference before and after the gate is
measured directly using a pressure gauge. This can then be converted to an
equivalent head loss using the equation

1 bar = 10.2m water
The loss coefficient may then be calculated as above for the gate valve.

Reynolds number is a dimensionless number used to compare flow characteristics. A
full investigation of Reynolds number, and typical flow variation as it changes, can be
found in experiment F1-20 (Reynolds’ Apparatus) or in a suitable fluids text baok.

Equipment Set Up

Set up the losses apparatus on the hydraulic bench so that its base is horizontal (this
is necessary for accurate height measurements from the manometers). Connect the
test rig inlet to the bench flow supply and run the outlet extension tube to the
volumetric tank and secure it in place.

Open the bench valve, the gate valve and the flow control valve and start the pump
to fill the test rig with water. In order to bleed air from pressure tapping points and the
manometers close both the bench valve and the test rig flow control valve and open
the air bleed screw and remove the cap from the adjacent air valve. Connect a length
of small bore tubing from the air valve to the volumetric tank. Now, open the bench
valve and allow flow through the manometers to purge all air from them; then, tighten
the air bleed screw and partly open both the bench valve and the test rig flow control
valve. Next, open the air bleed screw slightly to allow air to enter the top of the
manometers, re-tighten the screw when the manometer levels reach a convenient
height.

Check that all manometer levels are on scale at the maximum volume flow rate
required (approximately 17 litres/minute). These levels can be adjusted further by
using the air bleed screw and the hand pump supplied. The air bleed screw controls
the air flow through the air valve, so when using the hand pump, the bleed screw
must be open. To retain the hand pump pressure in the system, the screw must be
closed after pumping.

Results

It is not possible to make measurements on all fittings simultaneously and, therefore,
it is necessary to run two separate tests.

Test 1 measures losses across all pipe fittings except the gate valve, which should
be kept fully open. Adjust the flow from the bench control valve and, at a given flow
rate, take height readings from all of the manometers after the levels have steadied.
In order to determine the volume flow rate, you should carry out a timed volume
collection using the volumetric tank. This is achieved by closing the ball valve and
measuring (with a stopwatch) time taken to accumulate a known volume of fluid in
the tank, which is read from the sight glass. You should collect fluid for at least one
minute to minimise timing errors.

14



Exercise A

Repeat this procedure to give a total of at least five sets of measurements over a flow
range from approximately 8 - 17 litres per minute. Measure the outflow water
temperature at the lowest flow rate; this together with the table detailing the
Kinematic Viscosity of Water at Atmospheric Pressure is used to determine the
Reynolds number.

Test 2 measures losses across the gate valve only. Clamp off the connecting tubes
to the mitre bend pressure tappings (to prevent air being drawn into the system).
Start with the gate valve closed and open fully both the bench valve and the test rig
flow control valve. Now open the gate valve by approximately 50% of one turn (after
taking up any backlash). For each of at least 5 flow rates, measure pressure drop
across the valve from the pressure gauge; adjust the flow rate by use of the test rig
flow control valve. Once measurements have started, do not adjust the gate valve.
Determine the volume flow rate by timed collection.

Repeat this procedure for the gate valve opened by approximately 70% of one turn
and then approximately 80% of one turn.

Manometer | Manometer | Head | Vol | Time Flow | Velocity ‘,2/2 K
FITTING Loss Rots
I::n :: h1“':‘2 mgfs ‘s ms :m‘:.'s'

MITRE

ELBOW

|-SHORTBEND

ENLARGEMENT

CONTRACTION,

GATE VALVE Gauge-Reading =

Conclusion

For Test 1, plot graphs of head loss (&h) against dynamic head, and K against
volume flow rate Q.. .

For Test 2, plot graphs of equivalent head loss (Ah) against dynamic head, and K
against Q..

Comment on any relationships noticed. What is the dependence of head losses
across pipe fittings upon velocity?

Examining the Reynolds number obtained, are the flows laminar or turbulent?
Is it justifiable to treat the loss coefficient as constant for a given fitting?

In Test 2, how does the loss coefficient for a gate valve vary with the extent of
opening the valve?

15
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Kinematic Viscosity of Water at Atmospheric Pressure

Temperature Kinematic Temperature Kinematic
Viscosity Yiscosity
Vv by
(degrees C) (105 x m2is) (degrees C) {10 x mis)
0 1.793 2% 0.893
1 1032 20 -0.873
2 1.674 27 0.Be4
3 1.618 28 0.836
4 1.568 24 g.818
5 1.520 30 0.802
b 1474 31 0.795
I 1424 32 0.789
g 1.36b 34 0.753
Y 1.34b 24 0.738
10 1307 35 0724
1" 1.270 ab 0.1
12 1.235 3f 0.687
13 1207 38 0.684
14 1.169 34 0.671
15 1138 40 '0.658
16 1.108 45 U.602
17 1.080 80 0.554
18 1.053 o1s] 0.511
14 1.027¢ &0 0476
20 1.002 65 0.443
2 0.478 70 0.413
22 0.995 4 0.386
23 0433 gl U.364
24 HESNE) g5 U.342

Eg. At 20°C the kinematic viscosity of water is 1.002 x 10°m?s.

16




Operating the Optional Software (F1-301)

Note: The diagrams in this section are included as typical examples and may not
relate specifically to an individual product.

The Armfield Software is a powerful Educational and Data Logging tool with a wide
range of features. Some of the major features are highlighted below, to assist users,
but full details on the software and how to use it are provided in the presentations
and Help text incorporated in the Software. Help on Using the Software or Using the
Equipment is available by clicking the appropriate topic in the Help drop-down menu
from the upper toolbar when operating the software as shown:

§ isirwy Thes Sofbware.  F

Lty The Equipmest »

Aboet

Load the software. If multiple experiments are available then a menu will be
displayed listing the options. Wait for the presentation screen to open fully as shown:

BE L8 MEH-30T Fhuid Friction

E Theory
tations can help you
Experiment

[P TR &
Giuestions | How:

-« How o setup the

-« How to doth

Presentation Screen - Basics and Navigation

As stated above, the software starts with the Presentation Screen displayed. The
user is met by a simple presentation which gives them an overview of the capabilities
of the equipment and software and explains in simple terms how to navigate around
the software and summarizes the major facilities complete with direct links to detailed
context sensitive ‘help’ texts.

17
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To view the presentations click Next or click the required topic in the left hand pane
as appropriate. Click More while displaying any of the topics to display a Help index
related to that topic.

To return to the Presentation screen at any time click the View Presentation icon

from the main tool bar or click Presentation from the dropdown menu as
shown:

For more detailed information about the presentations refer to the Help available via
the upper toolbar when operating the software.
Toolbar

A toolbar is displayed at the top of the screen at all times, so users can jump
immediately to the facility they require, as shown:

The upper menu expands as a dropdown menu when the cursor is placed over a
name.

The lower row of icons (standard for all Armfield Software) allows a particular
function to be selected. To aid recognition, pop-up text names appear when the
cursor is placed aver the icon.

Mimic Diagram

The Mimic Diagram is the most commonly used screen and gives a pictorial
representation of the equipment, with boxes to enter measurements from the
equipment, display any calculated variables etc. directly in engineering units.

To view the Mimic Diagram click the View Diagram icon from the main tool bar

or click Diagram from the View drop-down menu as shown:

18



Operating the Software

A Mimic diagram is displayed, similar to the diagram as shown:

§422 bnaraybosses in Pipe Fit

The details in the diagram will vary depending on the equipment chosen if multiple
experiments are available.

Manual data input boxes with a coloured background allow measured variables,
constants such as Orifice Cd and Atmospheric Pressure, as appropriate, to be
changed by over-typing the default value. After typing the value press the Return key
or click on a different box to enter the value.

In addition to measured variables such as Volume, Time, Temperature or Pressure,
calculated data such as Discharge / Volume flowrate, Headloss etc are continuously
displayed in data boxes with a white background. These are automatically updated
and cannot be changed by the user.

After entering a complete set of data from measurements on the equipment click on

the icon to save the set of results before entering another set.

19
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The mimic diagram associated with some products includes the facility to select
different experiments or different accessories, usually on the left hand side of the
screen, as shown:

Clicking on the appropriate accessory or exercise will change the associated mimic
diagram, table, graphs etc to suit the exercise being performed.
Data Logging Facilities in the Mimic Diagram

Armfield software designed for manual entry of measured variables does not include
automatic data logging facilities and these options are greyed out where not

appropriate. When manually entering data the
entered data into a spreadsheet as described above.

icon simply saves the set of

Tabular Display

To view the Table screen click the View Table icon 7 from the main tool bar or
click Table from the View dropdown menu as shown:

20



Operating the Software

The data is displayed in a tabular format, similar to the screen as shown:

As the data is sampled, it is stored in spreadsheet format, updated each time the
data is sampled. The table also contains columns for the calculated values.

Ne sheets can be added to the spreadsheet for different data runs by clicking the

=== jcon from the main toolbar. Sheets can be renamed by double clicking on the
sheet name at the bottom left corner of the screen (initially Run 1, Run 2 etc) then
entering the required name.

For more detailed information about Data Logging and changing the settings within
the software refer to the Help available via the upper toolbar when operating the
software.

Graphical Display
When several samples have been recorded, they can be viewed in graphical format.

To view the data in Graphical format click the View graph icon from the main

tool bar or click Graph from the View drop-down menu as shown:

21
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The results are displayed in a graphical format as shown:

(The actual graph displayed will depend on the product selected and the exercise
that is being conducted, the data that has been logged and the parameter(s) that has
been selected).

Powerful and flexible graph plotting tools are available in the software, allowing the
user full choice over what is displayed, including dual y axes, points or lines,
displaying data from different runs, etc. Formatting and scaling is done automatically
by default, but can be changed manually if required.

To change the data displayed on the Graph click Graph Data from the Format
dropdown menu as shown:

22



Operating the Software

The available parameters (Series of data) are displayed in the left hand pane as
shown:

Two axes are available for plotting, allowing series with different scaling to be
presented on the same x axis.

To select a series for plotting, click the appropriate series in the left pane so that it is
highlighted then click the appropriate right-facing arrow to move the series into one of
the windows in the right hand pane. Multiple series with the same scaling can be
plotted simultaneously by moving them all into the same window in the right pane.

To remove a series from the graph, click the appropriate series in the right pane so
that it is highlighted then click the appropriate left-facing arrow to move the series into
the left pane.

The X-Axis Content is chosen by default to suit the exercise. The content can be
changed if appropriate by opening the drop down menu at the top of the window.

The format of the graphs, scaling of the axes etc. can be changed if required by
clicking Graph in the Format drop-down menu as shown:

For more detailed information about changing these settings refer to the Help
available via the upper toolbar when operating the software.
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Contact Details for Further Information

Main Office:

US Office:

Armfield Limited

Bridge House
West Street
Ringwood
Hampshire
England BH24 1DY

Tel: +44 (0)1425 478781

Fax: +44 (0)1425 470916

Email: sales@armfield.co.uk
support@armfield.co.uk

Web: http://www.armfield.co.uk

Armfield Inc.

9 Trenton - Lakewood Road
Clarksburg, NJ 08510

Tel/Fax: (609) 208 2800
Email: info@armfieldinc.com
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